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Getting Started
The client/server Seapine License Server stores license, user, and customer information on one
networked computer. Youmust have a Seapine License Server running on your network that other
Seapine products can access.

The Seapine License Server Admin Utility is used to perform the following tasks:

n Manage licenses

n Manage global users and customers

n Configure LDAP or Active Directory server support

n Manage license server options

n View andmanage the server log

n Manage license server admin security

Installing the license server and server admin utility
The Seapine License Server and Seapine License Server Admin Utility are installed when you install
Seapine products. If you did not install the license server components, rerun the installer and select an
installation type that includes the license server and admin utility.

Note: A web-based license server admin utility is also available. After installing the web admin utility,
youmust perform additional configuration on the web server that hosts the admin utility. See the
Surround SCM or TestTrack Installation Guide for information.

If you are upgrading Seapine products, always install the license server and admin utility. The license
server is backward compatible. It supports the Seapine product versions it is installed with and earlier
versions, but not later versions. To view the supported versions for the installed license server, choose
Help > About License Server in the admin utility.

Note: Licenses, users, and customers cannot be shared between license servers. Do not install and
usemultiple license servers unless you are sure the licenses, users, and customers will not be shared.
For example, your company may have stringent security requirements. Each department functions
separately and cannot share information because of legal or auditing reasons. In this case, each
department runs andmaintains a separate license server with its own set of licenses, users, and
customers.

About the 64-bit license server
The 64-bit version of the Seapine License Server is packaged in the 64-bit TestTrack Server and 64-bit
Surround SCM Server installers.

n 32-bit TestTrack and Surround SCM clients and the 32-bit Seapine License Server Admin Utility can
communicate with the 64-bit Seapine License Server and vice versa.
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Starting the Seapine License Server

n The 64-bit license server has different system requirements than the 32-bit server. Make sure the
server computer meets the recommended system requirements. See the Seapine License Server
System Requirements (www.seapine.com/kb/questions/1613).

New installations
If you are performing a new 64-bit license server installation, a SQLite server database is created
automatically the first time you start the license server. You can configure the server database to use a
different RDBMS. SeeSetting Up RDBMS Databases, page 49 andConfiguring the server
database, page 9.

Upgrade installations
If you are upgrading from the 32-bit Seapine License Server, youmust perform the steps in theMigrating
from the 32-bit Seapine License Server to the 64-bit Seapine License Server on the SameComputer
knowledgebase article (www.seapine/com/kb/questions/1612).

Starting the Seapine License Server
The Seapine License Server must be started before the Seapine server applications. If users cannot
connect to the server, make sure the server computer is online, the Seapine License Server application is
running, and the IP address and port number are correct.

n Windows—If the Seapine License Server is installed as an application, choosePrograms >
Seapine Software > Seapine License Server > Seapine License Server on the Start menu.

Note: If the license server is installed as a service, it starts automatically. If it does not start, refer
to theWindows documentation for help.

n Mac—Click Seapine License Server in the System Preferences. If you want to set the server to
start automatically, click the lock button and select Start Seapine License Server when this
computer starts up.

n Linux—Enter /usr/bin/spls start

Starting the Seapine License Server Admin Utility
You need to add licenses and users the first time you start the Seapine License Server and admin utility.
SeeAdding licenses, page 23 andAdding users, page 32.

Note: An administrative user is created during installation. Log in as this user the first time you start
the admin utility. The username is Administrator and there is no password. To prevent unauthorized
access, create a password for this user after you log in.

1. Windows—ChoosePrograms > Seapine Software > Seapine License Server > Seapine
License Server Admin on the Start menu.

Mac—Double-click theSeapine License Server Admin Utility icon in the Applications/Seapine
License Server folder.

Linux—Enter /usr/bin/lsadmin
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Adding server connections

The Seapine License Server Login dialog box opens.

2. Select theServer you want to connect to. SeeAdding server connections, page 3 if you need to
add a server.

3. Enter aUsername andPassword or select Use single sign-on to log in using the workstation
credentials.

Note: Single sign-onmust be enabled. Single-sign on is only available forWindows andMac.

4. Select Always login with this username and password to automatically log in with the credentials
you entered when the admin utility starts.

5. Click Connect.

The admin utility starts.

Adding server connections
Before you can access a license server, you need to add a server connection.

1. Choose File > Connect to Server to open the login dialog box.

2. Click Setup.

The Setup Server Connections dialog box opens.

3. Click Add.

The Add License Server dialog box opens.

4. Enter aServer Name.

Use a name that uniquely identifies the server. For example, Satellite Office.

5. Enter theServer Address of the computer where the license server is installed.

6. Enter server computerPort number.

Clients connect to the license server via TCP/IP on this port. The default value is 5100. Valid values
are 1-65535.

7. Click OK.

The server is added.

Note: Youmay want to move the servers you log in tomost frequently to the top of the list. To
reorder the servers, select a server and click Top, Move Up, Move Down, or Bottom.

Editing server connections
1. Choose File > Connect to Server to open the login dialog box.

2. Click Setup.

The Setup Server Connections dialog box opens.

3. Select the server you want to edit and click Edit.

The Edit License Server dialog box opens.

4. Make any changes.
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Finding servers

5. Click OK to save the changes.

Finding servers
You can quickly find all Seapine License Servers on the network.

1. Choose File > Connect to Server to open the login dialog box.

2. Click Setup.

The Setup Server Connections dialog box opens.

3. Click Find.

The Available License Servers dialog box opens when the search is complete. All available license
servers are displayed.

Note: Select Include IPv6 in scan to find servers hosted on IPv6 computers.

4. Select a server and click Add.

The Add License Server dialog box opens.

5. Enter a unique Server Name.

Note: The Server Address and Port fields are read-only and cannot be changed.

6. Click OK.

The server is added.

Connecting to a different server
You can connect to a different license server without closing the admin utility.

1. Choose File > Connect to Server.

The login dialog box opens.

2. Select the server you want to connect to and click Connect.

Deleting server connections
1. Choose File > Connect to Server to open the login dialog box.

2. Click Setup.

The Setup Server Connections dialog box opens.

3. Select the server you want to delete and click Delete.

You are prompted to confirm the deletion.

4. Click Yes to delete the server.
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Generating support diagnostic reports

Generating support diagnostic reports
If you are experiencing license server issues and need help from Seapine support, you can generate a
report that includes detailed information about the license server configuration. You can then email the
report to Seapine support to provide information for troubleshooting the issue.

1. ChooseHelp > Generate Support File.

TheGenerate Support File dialog box opens.

2. Click Save As to save the file.

The Save As dialog box opens.

3. Select aSave in location and enter a File name.

The default file name is SeapineSupportDiagnostics.txt.

4. Click Save.

5. Click Close.
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Configuring Server Options
You can configure various Seapine License Server options including log levels, password options, the
database type, and LDAP options.

Setting server log options
The license server creates log files that record events, such as severe errors or unusual activity, and help
youmonitor the server’s operation. SeeViewing the server log, page 47.

1. ChooseView > Server Options.

The Server Options dialog box opens.

2. Select the Log category.

3. Select aWrite to server log level to specify the types of events written to the log. SeeServer log
levels, page 8.

4. Select aWrite to NT event log orWrite to Unix system log level.

This option, which is named based on the operating system the license server is running on, specifies
the types of events written to the event or system log.

5. SelectWrite all log messages to LSStartup.log to write all messages to the log file.

Select this option if you are experiencing server problems and want to logmessages that occur after
startup. The LSStartup.log file is generally stored in the same directory as the Seapine License
Server executable onWindows and in /var/log on Unix. You can email the log file to Seapine
support for help resolving the problem.

Note: Startup errors are always logged to the LSStartup.log file.

6. Select Log warning if license server is not started as a service to log a warning if the license
server is started as an application. (Windows only)

Most companies run the license server application as a service. If it runs as an application, the
license server is shut down by the operating system when a user logs out, which can negatively
affect other users.

7. Select Log license usage to keep track of when licenses are used.
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Setting server options

You can use this data to determine the appropriate time to perform systemmaintenance and to see if
additional licenses are needed.

Note: The Seapine License Server can only provide usage reports for TestTrack 2009 and later
licenses, Surround SCM 2009 and later floating licenses, and Surround SCM 2010 and later
named licenses.

8. Click OK to save the changes.

Server log levels
The level of logging defines how detailed the server log is. A lower level, such as Unusual Activity,
provides more detail becausemultiple types of events are logged.

Level Writes an event to the log when:

Severe Error (1) A severe problem or critical condition occurs, such as a server failure.

Error (2) An error condition occurs, such as a failed connection attempt.

Warning (3) A warning condition occurs, such as the server not starting as an NT service.

Unusual Activity
(4)

Unusual activity occurs, such as a user trying to log in with an incorrect
username.

Information (5) Any significant action occurs, such as a user action timing out.

Note: Events for the selected level and all higher levels are logged. If you select Unusual Activity, the
server logs all severe error, error, warning, and unusual activity events.

Setting server options
1. ChooseView > Server Options.

The Server Options dialog box opens.

2. Select theServer category.
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Configur ing the server database

3. Select Encrypt messages sent to and from the license server to encrypt messages between the
license server, admin utility, and Seapine product servers.

Encryption increases security but may impact performance.

4. Enter the Listen for messages on port number.

5. Optionally enter and confirm aCommunications password.

Using a communications password provides additional security by requiring the Seapine product
servers to use a password to communicate with the license server.

If you change the communications password, youmust also change the password in Seapine
products or users cannot log in.

n To enter the password in TestTrack, log in to the TestTrack Server Admin Utility. Click Server
Options, and then select the License Server category. Enter the password in the Password
Settings area and click OK.

n To enter the password in Surround SCM, choose Tools > Administration > Server Options.
Click the License Server category. Enter the password in the Communication Settings area and
click OK.

Note: If users cannot log in because the communications password was not changed, the
administrator can use the default local admin credentials to correct the problem. Enter
Administrator as the username and leave the password field empty.

6. Select Enable renaming of usernames to allow administrators to change usernames.

Only select this option if you have a specific reason to change usernames, such as a corporate
security restrictions that require a standard username format.

7. Click OK to save the changes.

Configuring the server database
The Seapine License Server uses SQLite, a Relational DatabaseManagement System (RDBMS), for the
backend database by default. You can change the database location or convert the database to a use a
different RDBMS.

1. ChooseView > Server Options.

The Server Options dialog box opens.

2. Select theServer Database category.

The current license server type and location is displayed.
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Configur ing the server database

\

3. Click Change to change the database location. SeeChanging the server database, page 10.

4. Click Convert to convert the database to another type. SeeConverting the server database, page
11.

5. Make any changes to the RDBMS connection options.

n Validate RDBMS connection—Enter how frequently you want to validate the RDBMS
connection.

n Reattempt RDBMS connection—Enter how long the license server should attempt connecting
to an RDBMS server before initializing the server database. The license server attempts to
connect to RDBMS servers for oneminute by default. You can set the value between 0 and 10
minutes. There is a 20 second delay between each attempt. If you stop the license server while it
is connecting to an RDBMS server, it stops after the 20 delay ends. You cannot log in to the
license server while it is connecting to an RDBMS server.

6. Click OK to save the changes.

Changing the server database
You can configure the Seapine License Server to use a different server database location. For example,
youmove the database to another computer or experience problems and want to use a backup copy of
the database. You should not need to frequently change the server database location.

1. Make sure you are logged into the license server that uses the database you want to change. Choose
File > Connect to Server to connect to a different server.

2. ChooseView > Server Options.

3. Select theServer Database category.

4. Click Change.

The License Server Database Configuration dialog box opens.
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Configur ing the server database

5. Select aDatabase Type.

6. Enter theConnection Information.

The available fields change based on the selected database type.

7. Click Test to test the connection.

The Test Connection dialog box opens and displays the results.

Tip: If the test connection fails, contact your DBA or internal support department for help.

8. Click Close to close the Test Connection dialog box.

9. Click OK to change the database location.

The following information is verified if you selected ODBC - SQL Server or Oracle Native:

n The specified information connects to a valid database.

n The database is not used by another Seapine License Server.

n The required database tables exist and are accessible. If the database does not contain any
license server tables, you are prompted to create them. SeeAutomatically creating Seapine
License Server tables, page 13.

10. You return to the Server Database category. Click OK to save the changes.

Stop and restart the license server to complete the process.

Converting the server database
You can convert the Seapine License Server database to a different RDBMS type. SQLite, ODBC - SQL
Server, Oracle Native, and PostgreSQL are supported.

Keep the following inmind before you start the conversion:

n The database you are converting tomust be created before the conversion (except SQLite).

n All tables in the physical databasemust be empty (except SQLite).
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Configur ing the server database

n The database you are converting cannot be in use by another Seapine application or another license
server.

n All other users must be logged out of the license server and admin utility.

Note: If you are converting to ODBC - SQL Server, we recommend that youmanually create the
server database tables. The license server can also create the tables during the conversion. See
Automatically creating Seapine License Server tables, page 13.

1. Make sure you are logged into the license server you want to convert the database for. Choose File >
Connect to Server to connect to a different server.

2. ChooseView > Server Options.

3. Select theServer Database category.

4. Click Convert.

The License Server Database Conversion dialog box opens.

5. Select aDatabase Type.

6. Enter theConnection Information.

The available fields change based on the selected database type.

Note: You are not prompted for connection information or to test the connection if you are
converting to SQLite. The database is automatically converted into the C:\Program
Files\Seapine\License Server\LicenseServDb directory.

7. Click Test to test the connection.

The Test Connection dialog box opens and displays the results.

Tip: If the test connection fails, contact your DBA or internal support department for help.

8. Click OK to close the Test Connection dialog box.

9. Click OK to convert the database.

You are prompted to start the conversion.
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Automatical ly creating Seapine License Server tables

10. If you want to use the converted database immediately after the conversion finishes, select Use
converted database.

If you do not select this option, you canmanually change the database the license server is using
after the conversion. SeeChanging the server database, page 10.

11. Click Yes.

The Conversion Status dialog box opens and the conversion starts.

12. Click Closewhen the conversion finishes.

13. Stop and restart the license server to complete the conversion process.

Automatically creating Seapine License Server tables
When you upgrade or convert the Seapine License Server database, the physical database and empty
tables must be created before data can be converted. If the tables do not exist, you are prompted to allow
the license server to create them. SeeSetting Up RDBMS Databases, page 49.

1. The Choose RDBMS Vendor dialog box opens when you are upgrading or converting the license
server database.

2. Select theRDBMS vendor and click OK.

3. The server loads the corresponding table creation script and sends it to the database server.

Table creation scripts are stored in a configuration text file, which allows DBAs to use the script to
help manually create tables or edit database attributes.

Setting password options
You can set options to enforce your company’s password requirements and provide greater security.
These password options only affect users stored on the Seapine License Server and do not apply to users
associated with LDAP. Refer to your LDAP server documentation to set password restrictions on the
LDAP server.

1. ChooseView > Server Options.

The Server Options dialog box opens.

2. Select thePasswords category.
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Setting password options

3. Enter any Password Requirements to require aminimum password length or minimum number of
specific character types.

This can help you set strict password requirements that make it more difficult for unauthorized users
to crack.

4. Select any Password Restrictions.

Requiring users to change passwords periodically adds to security andmay also be required by
compliance programs, such as 21 CFR Part 11.

5. Select a password reuse option.

Preventing users from reusing passwords minimizes the risk of unauthorized users finding and using
passwords.

6. Select Lock user after failed logins to prevent users from logging in to Seapine products after the
specified number of failed logins.

Select Lock expires after to set the number of hours before the lock is released and the user can log
in to Seapine products.

Note: If a user is locked, an administrator must unlock them on the license server before they can
log in. SeeUnlocking users, page 37. Restarting the license server does not release locks, but it
resets the number of failed logins to 0.

7. Click OK to save the changes.
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Setting LDAP options

Setting LDAP options
The Seapine License Server supports LDAP, making it easy tomanage and share information.

1. ChooseView > Server Options.

The Server Options dialog box opens.

2. Select the LDAP category.

3. Select an LDAP retrieval option.

n Do not use LDAP disables LDAP support.

n Users can be retrieved from LDAP enables LDAP support, allows adding users from an LDAP
server, and allows manually adding users that are not stored on an LDAP server.

n Users must be retrieved from LDAP enables LDAP support and prevents administrators from
adding users that are not stored on an LDAP server.

4. Select the re-sync frequency to specify how often the license server re-syncs with the LDAP server
to update user information.

Note: You can alsomanually re-sync LDAP users. SeeRe-syncing LDAP users, page 36.

5. Click OK to save the changes.

Adding LDAP servers
1. ChooseView > Server Options.

2. Select the LDAP category.

15



Setting LDAP options

3. Click Add LDAP.

The Add LDAP Server dialog box opens.

4. Enter a descriptiveName for the LDAP server.

5. Enter the LDAP server IP address or alias as theHost.

For example, ldap.wysicorp.com.

6. Enter the LDAP server Port number.

The default port is 389.

Note: If the license server is running onWindows and you select the Use SSL option, the port
number automatically changes to 636, which is the standard port for LDAP SSL onWindows. The
standard LDAP SSL port on Unix is 389.

7. Enter theBase directory DN.
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Setting LDAP options

This field specifies where to start searching from in the LDAP tree. For example, your Base DN is
wysicorp.com and includes development, sales, and support nodes. Entering o=sales, dc=wysicorp,
dc=com instructs the license server to start searching from sales.

8. Select Use SSL to encrypt authenticationmessages sent over the network.

Selecting this option requires the license server to use the Secure Sockets Layer (SSL) protocol
when sending and receiving authentication transmissions between the license server, the LDAP
server, and Seapine products. We recommend selecting this option if the license server is configured
to use simple password encryption.

9. Select the type of Password encryption to use when sending usernames and passwords over the
network.

n Simplesends usernames and passwords as plain text. We recommend selecting theUse SSL
option if you use simple password encryption. The Username and Password fields are required if
this option is selected.

n DIGEST-MD5 sends usernames and passwords as encrypted text. This option is only available if
the license server is running on Unix. The Username, User DN, and Password fields are required
if this option is selected.

10. Optionally enter theHost address andPort number of a backup server.

The backup server is only queried if the primary server cannot be reached.

11. Select Use anonymous binding for query to anonymously access the LDAP server.

Youmust be an authenticated, non-anonymous user if you want to perform LDAP operations, such
as password checking.

12. Enter aUsername, User DN, andPassword if anonymous binding is not enabled.

n Username is the name of the user you want to use to connect to the LDAP server. The license
server will try to automatically connect to the LDAP server using one of the supported SASL
authenticationmechanisms.

n User DN is the distinguished name (DN) of the user. This sequence of attributes and values
specifies the location of an entry in the LDAP tree. For example: cn=Administrator, cn=users,
dc=addoej, dc=wyiscorp,dc=com.

n Password is the password of the user you want to use to connect to the LDAP server.

13. Select an LDAP user attribute and click Edit to map the attribute to a license server user field. See
Mapping LDAP attributes, page 20.

14. Click Test LDAP Connection to test the LDAP server connection.

If the connection is not successful, correct any mistakes and retest it.

15. Click OK to save the changes.

The server is added.

Tip: Servers are queried in the order they are displayed. To reorder the servers, select a server
and click Top, Move Up, Move Down, or Bottom.

Adding Active Directory servers
1. ChooseView > Server Options.
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Setting LDAP options

2. Select the LDAP category.

3. Click Add Active Directory.

The Add Active Directory Server dialog box opens.

4. Enter a descriptiveName to identify the Active Directory server.

5. Enter the IP address or alias for the Active Directory server as theHost.

6. Enter thePort number where the Active Directory server resides.

The default port is 389.
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Setting LDAP options

Note: If the Seapine License Server is running onWindows and you select the Use SSL option,
the port number automatically changes to 636, which is the standard port for LDAP SSL on
Windows. The standard LDAP SSL port on Unix is 389. Contact your system administrator if you
do not know which port number to use.

7. Select Use SSL to encrypt authenticationmessages sent over the network.

Selecting this option requires the Seapine License Server to use the Secure Sockets Layer (SSL)
protocol when sending and receiving authentication transmissions between the license server, the
LDAP server, and Seapine products. We recommend selecting this option if the license server is
configured to use simple password encryption.

8. Enter theWindows Domain name the Active Directory services.

9. Enter theUsername andPassword for the Active Directory user used to bind to the Active
Directory.

10. Select aSingle Sign-On option.

Single sign-on allows LDAP users to automatically log in to Seapine products using the same
credentials used to log in to their computer. For example, your organizationmay use a non-password
login method, such as a secure ID token or biometrics. Single sign-on uses the same authentication
to log in to Seapine products. SeeConfiguring single sign-on for LDAP servers, page 45.

11. Click Auto Configure to query the Active Directory server for the configuration information. Click
Advanced to manually enter this information.

n Enter theBase DN. This field specifies where to start searching from. For example, your Base
DN is wysicorp.com and includes development, sales, and support nodes. Entering o=sales,
dc=wysicorp, dc=com instructs the license server to start searching from sales.

n Enter theUser DN. This sequence of attributes and values specifies the location of an entry. For
example: cn=Administrator, cn=users, dc=addoej, dc=wysicorp, dc=com.

n Optionally enter theHost address andPort number of a backup server. The backup server is only
queried if the primary server cannot be reached.

n Select an LDAP user attribute and click Edit to map the attribute to a license server user field.
SeeMapping LDAP attributes, page 20.
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Note:When you auto configure the settings, the license server queries the Active Directory
server for rootDSE information and retrieves the Base DN information. Next, the license server
searches for the authentication user’s User DN. After this DN is found, the user’s CN value is
removed and the remaining data is used as the final Base DN. For example, the license server
queries an Active Directory server for rootDSE information and retrieves “dc=seapine,dc=com” as
the Base DN. Next, the license server queries the Active Directory server for the authentication
user's User DN and retrieves “cn=Virtual User, cn=Users,dc=seapine,dc=com”. Finally, the
license server trims off the user’s CN value and uses “cn=Users,dc=seapine,dc=com” as the
Base DN.

Due to performance reasons, we recommend using a subtree Base DN (e.g., cn=Users,
dc=seapine, dc=com) instead of the topmost Base DN (e.g., dc=seapine,dc=com). If the topmost
Base DN is used, it may cause a large amount of unnecessary network traffic. If users are
dispersed across the Active Directory tree, we also recommend that you createmultiple Active
Directory server entries.

12. Select the type of Password encryption to use when sending usernames and passwords over the
network.

n Simple sends usernames and passwords as plain text. We recommend selecting theUse SSL
option if you use simple password encryption. The Username and Password fields are required if
this option is selected.

n DIGEST-MD5sends usernames and passwords as encrypted text. The Domain, Username, User
DN, and Password fields are required if this option is selected.

n GSSAPI uses advanced encryption for usernames and passwords. This option is only available if
the license server is running onWindows and is recommended to ensure secure authentication.

13. Select Synchronize user activation to automatically sync user activation between Active Directory
and the license server. If a user is disabled or enabled in Active Directory, the user is inactivated or
activated on the license server.

14. Click Test Connection to test the Active Directory server connection.

If the test is not successful, correct any mistakes and retest the connection. Click Reset to clear all
information.

15. Click OK to save the changes.

The server is added.

Tip: Servers are queried in the order they are displayed. To reorder the servers, select a server
and click Top, Move Up, Move Down, or Bottom.

Mapping LDAP attributes
You canmap license server user fields to LDAP and Active Directory fields to import all the information in
a user record to the license server.

1. When adding or editing an LDAP or Active Directory Server, select a user attribute and click Edit.

The Edit Attribute dialog box opens.
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2. Enter the LDAP Field you want to map to the license server user field and click OK.

You can enter the LDAP field name tomap a single attribute to the field or use an expression tomap
multiple attributes to the field. Append and prepend the LDAP field namewith a percentage sign (%).
For example, the expression%organization% %company% maps theOrganization and Company
LDAP attributes to a license server user field. Any empty fields are not set for all users on the LDAP
server.

The license server uses the following backup field expressions if the primary field is unavailable or
empty.

User field LDAP attribute

Company company

Address %postOfficeBox%
%streetAddress%
%l%, %st% %postalCode%

3. Click Preview Users to preview the field mappings. SeePreviewing mapped LDAP attributes,
page 21.

4. Click OK to save the changes.

Previewing mapped LDAP attributes
You can preview custom LDAP attributemappings to see how LDAP fields are displayed in license
server user records.

1. Click Preview Users when you are adding or editing an LDAP or Active Directory server.

The Preview LDAP Users dialog box opens.

2. Select a user to preview and click Preview.

The Preview LDAP Users dialog box opens. LDAP data from the field mappings is displayed on the
Info and Address tabs.

Note: If you selectedmultiple users, click the arrow buttons to preview each user.

3. Click Close to close the preview.

Editing LDAP servers
1. ChooseView > Server Options.

2. Select the LDAP category.
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3. Select the server you want to edit.

4. Click Edit.

The Edit Server dialog box opens.

5. Make any changes.

6. Click OK to save the changes.

Inactivating LDAP servers
You can inactivate LDAP and Active Directory servers to remove them from the list of queried servers.

1. ChooseView > Server Options.

2. Select the LDAP category.

3. Select the server you want to inactivate.

4. Click Inactivate.

The server is no longer active and will not be queried.

5. Click OK to save the changes.

Deleting LDAP servers
When you delete an LDAP or Active Directory server, any users associated with it are inactivated and
cannot access Seapine products.

1. ChooseView > Server Options.

2. Select the LDAP category.

3. Select the server you want to delete.

4. Click Delete.

You are prompted to confirm the deletion.

5. Click Yes to delete the server.

Make sure you want to delete the server. This action cannot be undone.

6. Click OK to save the changes.
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Seapine's flexible licensingmodel allows you to use the right mix of licenses for your company's specific
needs. Product licenses aremanaged globally with the Seapine License Server, reducing license
administration time.

Seapine products include floating and named licenses. Floating licenses are best for users who log in
occasionally while named licenses are best for users who log in frequently.

n A floating license can be used by anyone on the network, up to the limit specified on the Seapine
License Server. The license server tracks the number of available floating licenses. When a user logs
in, the corresponding total used floating license number increases by one. If more users than allowed
by the floating license try to log in, they are denied access.

n A named license is dedicated to a specific user and allows the user to run the product from any place
on the network. Named licenses cannot be shared. In addition, the Seapine License Server Admin
Utility tries to automatically associate existing named license users with corresponding named
licenses. For example, if you edit a 5-user named license and replace it with a 3-user named license,
the license server admin utility tries to reassociate the remaining users with another named license.

Note: Each TestTrack license includes a license for the SOAP-based SDK.

Adding licenses
When you purchase a new product license or receive amaintenance extender key, you need to add the
key to the license server before the product can be used.

Note: You canmanually enter license keys or upload the .lic file that is attached to the email you
received with the license keys. We recommend uploading the .lic file, which needs to be saved to your
hard drive or another accessible location.

1. ChooseView > Licenses.

The Seapine Licenses dialog box opens.

2. Click Add.

The Add License dialog box opens.

3. Click Browse to select a license file. Licenses have a .lic file extension.

4. Select the license file and click Open.

Tip: If youmanually enter a license, the Serial Number field is case sensitive. Licenses can be
entered with or without dashes.

5. Click OK.

The serial number is added. If you are adding amaintenance extender key, the existing key is
updated. You do not need to delete existing licenses.
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Configuring license pools
You can configure license pools to assign specific floating licenses to a group of users. This helps ensure
a certain number of floating licenses are available for different groups of users. For example, you can
create a license pool for occasional users to share and another license pool for developers to guarantee
that developers always have access to a license.

Note: All available licenses that are not dedicated to a specific pool are included in the default Floating
license pool for each product. Users assigned to a license pool cannot use licenses from the default
pool.

1. ChooseView > Licenses.

The Seapine Licenses dialog box opens.

2. Click Configure Floating Pools.

The Configure Floating License Pools dialog box opens.

3. Click Add to create a new license pool. SeeAdding license pools, page 24.

4. Select a license pool and click Edit to modify it. SeeEditing license pools, page 25.

5. Select a license pool and click Delete to delete it. SeeDeleting license pools, page 26.

6. Click Close to close the dialog box.

Adding license pools
You can create license pools to specify the number of floating licenses available to a group of users.

1. ChooseView > Licenses.

The Seapine Licenses dialog box opens.

2. Click Configure Floating Pools.

The Configure Floating License Pools dialog box opens. The available product licenses are listed in
the default Floating pool for each product.
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3. Click Add.

The Add License Pool dialog box opens.

4. Enter a license pool Name.

Note: The license pool namemust be between 1 and 40 characters.

5. Select aProduct.

The available licenses for the selected product are grouped by serial number.

6. Select a license from theAvailable licenses list.

To select multiple licenses, Ctrl+click the licenses. To select all the available licenses from a serial
number, click the serial number.

7. Click Add to add the license to the pool.

To remove a license from the pool, select the license and click Remove.

8. Click OK.

The license pool is added. The licenses in the pool can only be used by the users assigned to the
license pool. SeeAssigning users to license pools, page 26.

Editing license pools
1. ChooseView > Licenses.

The Seapine Licenses dialog box opens.
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2. Click Configure Floating Pools.

The Configure Floating License Pools dialog box opens.

3. Select a license pool and click Edit.

The Edit License Pool dialog box opens.

4. Make any changes.

5. Click OK to save the changes.

Deleting license pools
1. ChooseView > Licenses.

The Seapine Licenses dialog box opens.

2. Click Configure Floating Pools.

The Configure Floating License Pools dialog box opens.

3. Select a license pool and click Delete.

4. You are prompted to confirm the deletion.

5. Click Yes.

The license pool is removed from the list.

Note: License pools are not deleted from the server database. If a license pool is deleted in the admin
utility, the record for the pool is marked as deleted in the database table.

Assigning users to license pools
You can assign users to license pools when assigning floating licenses.

Tip: To assignmultiple users to a license pool, select the users in the Global Users list and replace the
license field values for the users. SeeReplacing license field values, page 42

1. ChooseView > Global Users.

TheGlobal Users dialog box opens.

2. Click Add to assign a new user to a license pool or select an existing user from theGlobal Users list
and click Edit.

The Add User or Edit User dialog box opens.

3. Click the Licenses tab.

4. Click the corresponding Seapine product license button.

The Assign License dialog box opens.
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5. Select Use floating license and a license pool from the list. The Floating license pool is the default
pool of available product licenses.

6. Click OK to close the Assign License dialog box.

7. Click OK to save the changes.

The user is assigned to the license pool.

Assigning licenses
You can assign or change user licenses from theGlobal Users list. This is generally quicker than editing
specific users to assign licenses or change their license information.

Tip: You can view the named licenses assigned to users in the Global Users list. If the product serial
number column is not displayed, right-click a column heading and select the Serial Number field. Only
the last four digits of the serial number are displayed for security purposes.

1. ChooseView > Global Users.

TheGlobal Users dialog box opens.

2. Select the users you want to assign licenses to.

To select multiple users, Ctrl+click each user.

3. Click the corresponding Seapine product button. Buttons are only available for products with licenses
entered in the admin utility.

The Assign License dialog box opens.

4. Select a license type.

Note: You cannot assign named licenses to inactive users.
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5. Click OK.

The licenses are assigned to the users.

Associating users with named licenses
You can quickly associate or disassociate users with named licenses. You cannot associate named
licenses with inactive users.

Note: You can also assign or change user licenses from theGlobal Users dialog box. SeeAssigning
licenses, page 27.

1. ChooseView > Licenses.

The Seapine Licenses dialog box opens.

2. Select a named license.

3. Click Associate Users.

The Associate Users with Named License dialog boxopens.

4. Select an available user and click Add to associate the user with the selected license.

To disassociate users, select an associated user and click Remove.

5. Click OK to save the changes.

Viewing used licenses
You can view the number of licenses used, which users are accessing a floating license, and the order
users logged in.

1. ChooseView > Licenses.

The Seapine Licenses dialog box opens.

2. Click Licenses in Use.

The Licenses in Use dialog box opens and displays the total licenses in use and the available floating
licenses.
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3. Click Refresh to update the list.

4. Click Close to close the dialog box.

Viewing license counts
You can view the number of current and expired licenses stored on the Seapine License Server by type
and product.

1. ChooseView > Licenses.

The Seapine Licenses dialog box opens.

2. Expand the Total License Counts area.

The license counts are displayed. Expanded evaluation licenses are not included.
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Viewing license details
1. ChooseView > Licenses.

The Seapine Licenses dialog box opens.

2. Select the license and click View.

The read-only License Details dialog box opens. The information in the dialog box changes based on
the license type.

Deleting licenses
1. ChooseView > Licenses.

The Seapine Licenses dialog box opens.

2. Select the license and click Delete.

You are prompted to confirm the deletion.

3. Click Yes.

The license is deleted.
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Global users can be shared among Seapine products. Use the Seapine License Server Admin Utility to
create global users.

Tip: You can also create users directly in Seapine products.

Customizing the Global Users list
You can customize the Global Users list and set up the columns to display the information you need.

To open theGlobal Users dialog box, click Global Users or chooseView > Global Users.

Tip: You can use type ahead searching to quickly find users in the Global Users dialog box. Enter the
characters you are searching for. Matching text is highlighted as you type. Press Ctrl+] to find the next
match or Ctrl+[ to find the previous match. Press Esc to clear the search.

Changing column contents
You can change column contents to display the information you usemost frequently.

1. Right-click a column heading.

The available fields are displayed. Check marks indicate columns that are currently displayed.

2. Select a column.

The column is added and the user information is displayed. To remove a column, right-click it and
select the column from themenu.

3. Click and drag the column to change its location.

Sorting columns
You can sort by any column in the Global Users list. You can also perform primary and secondary sorts.

n Click a column heading to perform a primary sort. An arrow is displayed next to the heading. Click the
column heading again to toggle the sort order.

n Shift+click a column heading to perform a secondary sort. A double arrow is displayed next to the
heading. Shift+click the column heading again to toggle the sort order.

Filtering columns
You can filter columns in the Global Users list to view users that match specific criteria.

n Click the funnel icon in the column heading to apply a filter. A green arrow indicates that a filter is
applied to a column.
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n Select Custom in the filter list to select multiple column values or to search for specific column text.
Use theMatch Column Text dialog box to set specific criteria to filter the Name, Username, Phone
Number 1, Phone Number 2, Email Address, Address, and Notes columns. Use theSelect Column
Values dialog box to select multiple criteria to filter all remaining columns that use defined values.

Adding users
1. ChooseView > Global Users.

TheGlobal Users dialog box opens.

Tip: You can customize the information displayed in the Global Users list. SeeCustomizing the
Global Users list, page 31.

2. Click Add and then select Add User.

The Add User dialog box opens with the Info tab selected.

n Enter the user’s First name and Last name. Optionally enter the user’s middle initial in theMI
field.
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n Enter a uniqueUsername. Most organizations use a combination of the first and last names.

Note: First name, Last name, and Username are required. All other fields are optional.

n Enter the user’s Phone Numbers.

n Select an email type and enter theEmail Address.

n Enter and confirm aPassword. Select any password options.

n Select aUser Type. Some companies may provide customers with limited access to Seapine
products. In this case, youmay want to create a global customer.

n ClearActive to create an inactive user.

3. Click theSecuritytab to select security permissions for the user.

n User cannot login to the license server admin utility prevents users from accessing the
admin utility. This is the default option and is recommended for most users.

n User can retrieve global users, but cannot login to the license server admin utility allows
users to only retrieve global users in Seapine products.

n User can only manage global users allows users to create andmaintain global users.

n User can administer all license server functions provides access to all admin utility
commands. You should only select this option for administrative users.

4. Click the Licenses tab to select licenses for the user.

Click the corresponding Seapine product button and select a license. If you are assigning a floating
license, you can also select a license pool to limit the number of licenses available to the user. See
Assigning users to license pools, page 26.

5. Click theAddress tab to enter the address and select the company, division, and department.
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If you have a large number of users, setting the Company, Division, and Department fields can help
you group users. You can enter or select values in these fields. If you enter a value, it is saved and
can be selected for other users and customers. You can enter up to 64 characters.

The Division field values are based on the selected Company value. The Department field values are
based on the selected Division value.

6. Click theNotes tab to add any notes about the user.

7. Click OK to add the user.

Adding LDAP users
If the Seapine License Server is configured to connect to an LDAP server, you can retrieve users from the
LDAP database.

Note: The license server cannot support LDAP users with empty Name or Username fields. If you
create an LDAP schema, make sure you enter the custom attributes when you add the LDAP server.
SeeSetting LDAP options, page 15.

1. ChooseView > Global Users.

TheGlobal Users dialog box opens.

2. Click Add and then select Add LDAP User.

The Add LDAP User dialog box opens.

3. Select any Filter criteria to narrow the search results.

Do not select any search criteria if you want to return a list of all LDAP users.

n Enter aName to search for LDAP users by name. This field supports wildcards.

n Enter aUsername to search for LDAP users by username. This field supports wildcards.

n Select Exclude existing license server users if you do not want to include existing users.
Users that have been deleted from the license server are included in the list if this option is
selected. The username field determines if a user exists on the license server.

n Select Limit results to and enter themaximum number of returned records.

4. Click Query LDAP Servers.

A list of matching users is displayed in the Search Results area.
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5. Select the users you want to add to the license server.

n Click Add to addmultiple users. After the users are added, make sure you assign license types
and set security permissions for each user.

n Click Advanced Add to add one user to the license server and open the Add User dialog box.
Most of the user information is populated from the LDAP record and cannot be edited. Make sure
you assign a license to the user and set server security permissions. You can also enable single
sign-on if it is enabled for the LDAP server. SeeEditing users, page 35.

6. Click Closewhen you finish adding LDAP users.

Note: LDAP users can access Seapine products after they are added to the license server and
assigned a license. If the Seapine product servers are already running, it may take a few minutes for
the changes to take effect.

Viewing users
You can view read-only user information.

1. Select the users you want to change in the Global Users list.

2. Select a user and click View.

The View User dialog box opens.

Editing users
You can edit most user information including security and licenses. If you are an administrator, youmay
also be able to edit the username. SeeChanging usernames, page 36.

Tip: You can easily enable and disable single sign-on in the Quick Edit area on theGlobal Users dialog
box. You can also activate and inactivate users.

1. ChooseView > Global Users.

TheGlobal Users dialog box opens.

2. Select a user and click Edit.

The Edit User dialog box opens.

3. Select Allow user to authenticate using single sign-on to enable single sign-on.

Single sign-on allows users to log in to Seapine products using their network credentials. This option
is only available for LDAP users and if single sign-on is enabled for the LDAP server. SeeSetting
LDAP options, page 15 andEnabling single sign-on for users, page 46.

Note: If single sign-on is required for all users associated with the LDAP server, theUser is
required to authenticate with single sign-on option is selected by default and cannot be
changed.

4. Make any LDAP user association changes.
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n Click Associate with LDAP User to associate the selected user with an LDAP record.

n Click Re-associate if you are editing an LDAP user who is experiencing problems. The license
server is updated with any new or changed LDAP record data.

n Click Disassociate from LDAP if you are editing an LDAP user and want to remove the LDAP
association. The user is changed to a global non-LDAP user.

5. Make any other changes.

6. Click OK to save the changes.

Changing usernames
You should only edit usernames if a new business process or security restriction requires it. The old
username can only be used by the original user and cannot be assigned to other users.

Note: If you are using TestTrack Pro 6.x or earlier or Surround SCM 2.x or earlier, do not edit
usernames. Users will not be able to log in if you change their usernames.

1. ChooseView > Global Users.

TheGlobal Users dialog box opens.

2. Select a user and click Edit.

The Edit User dialog box opens.

3. Enter a new username and click OK.

You are prompted to confirm the username change.

4. Click OK to save the changes.

The username is changed. The old username is added to the Notes tab.

Re-syncing LDAP users
You canmanually re-sync LDAP users if you do not want to wait for the information to be automatically
updated.

1. ChooseView > Global Users.

TheGlobal Users dialog box opens.

2. Select the users you want to re-sync.

All LDAP users are re-synced if you do not select specific users.

3. Click Re-Sync LDAP Users.

The user information is re-synced.

Note: You can also set the server to re-sync automatically. SeeSetting LDAP options, page
15.

Inactivating users
Inactive users cannot log in to Seapine products.
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1. ChooseView > Global Users.

TheGlobal Users dialog box opens.

2. Select the user you want to inactivate.

3. Click Quick Edit and then select Inactivate.

The user is inactivated.

Note: If the user is assigned a named license, you are prompted to confirm the inactivation.
Named licenses cannot be assigned to inactive users.

Activating users
Activate an inactive user to allow them to log in.

1. ChooseView > Global Users.

TheGlobal Users dialog box opens.

2. Select the user you want to activate.

3. Click Quick Edit and then select Activate.

The user is activated. Youmay need to assign a license to the user. SeeAssigning licenses, page
27.

Unlocking users
A user may be locked after failing to log in to Seapine products. You can unlock users to restore access.

Note: You can set failed login lockout options on the license server. SeeSetting password options,
page 13.

1. ChooseView > Global Users.

TheGlobal Users dialog box opens.

2. Select a locked user.

Note: To unlock multiple users, select the users in the Global Users list, click Quick Edit, and
then select Unlock. You can add the Locked column to the Global Users list to easily see which
users are locked. SeeCustomizing the Global Users list, page 31.

3. Click Edit.

The Edit User dialog box opens. The locked indicator is displayed.
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4. Click Unlock. This button is only available if the user is locked.

The user is unlocked and can log in to Seapine products.

Exporting user information
User information can be exported as an XML file, which allows you to import the information into another
Seapine License Server or application or use it with any XML-compatible tool.

1. Choose File > XML Export.

The XMLExport dialog box opens.

2. Select Encrypt Passwordsto encrypt passwords in the XML file.

3. Click Export.

The Export dialog box opens.

4. Select aSave in location and enter a File name.

5. Click Save.

The file is exported.
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Importing user information
User information can be imported from an XML file. This lets you import information from another Seapine
License Server or application.

If the XML file was exported from the license server, licenses are assigned based on information in the
XML file. If a matching license type is not available, a license is not assigned.

1. Choose File > XML Import.

The XML Import dialog box opens.

2. Click Browse to select a file.

3. Select the file and click Open.

You return to the XML Import dialog box, which is populated with the file information.

4. Click Validate XML File to validate the file.

Tip: The XML Import Warnings and Error dialog box opens if any issues are found. You should try
to correct errors before importing the file.

5. Click Importwhen you are ready to import the XML file.

The user information is imported.

Deleting users
When you delete users, their demographic information is also deleted. Inactivate users to save this
information.

1. ChooseView > Global Users.

TheGlobal Users dialog box opens.

2. Select the user and click Delete.

You are prompted to confirm the deletion.

3. Click Yes.

The user is deleted.

Undeleting users
The Seapine License Server tracks deleted users and allows you to undelete them. For example, you
may delete a user by mistake or need to reuse a specific username.

Note: Historical information can change if a usernamewas used and you assign it to a different user.
Youmust alsomaintain unique usernames to remain compliant with regulatory and other requirements.
If you undelete a user, and assign the username to someone else, youmay risk compliance.

1. ChooseView > Global Users.

TheGlobal Users dialog box opens.

2. Click Undelete Users.
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The Undelete Users dialog box opens. A list of all deleted users is displayed.

3. Select one or more users and click Undelete Users.

The users are undeleted and removed from the list.

Printing the global users list
You can print the information in the Global Users dialog box.

1. ChooseView > Global Users.

TheGlobal Users dialog box opens.

2. Click thePrint button.

The Print Users List dialog box opens. The Selected columns list includes the columns that are
currently displayed in the Global Users window.

3. Select the column you want to add in the Available columns list and click the right arrow tomove it to
the Selected columns list.

To remove a column, select the column in the Selected columns list and click the left arrow tomove it
to the Available columns list.

4. Select a column in the Selected columns list and click Top, Move Up, Move Down, or Bottom to
change the display order.

5. Click Print.

The Print dialog box opens.

6. Select any options and click Print.

Changing bulk user fields
Bulk user changes allow you to changemultiple user records at once. You can change info, security,
license, address, and notes fields.

Note: Users must have security permissions to administer all license server functions or manage
global users to perform bulk user changes. SeeAdding users, page 32.
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Replacing info field values
LDAP user phone numbers and email addresses cannot bemodified.

1. Select the users you want to change in the Global Users list.

2. Click Quick Edit and then select Bulk User Changes.

The Bulk User Changes dialog box opens with the Info tab selected.

3. Make any changes. The available options depend on the field type.

To set the field to a new value, select Set and enter a value.

4. Click OK to save the changes.

Replacing security field values
1. Select the users you want to change in the Global Users list.

2. Click Quick Edit and then select Bulk User Changes.

The Bulk User Changes dialog box opens with the Info tab selected.

3. Click theSecurity tab.
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4. Make any changes. The available options depend on the field type.

n To change the security rights, select Set to value and select a value.

n To enable single sign-on, select Set checked. To disable single sign-on, select Set unchecked.

5. Click OK to save the changes.

Replacing license field values
1. Select the users you want to change in the Global Users list.

2. Click Quick Edit and then select Bulk User Changes.

The Bulk User Changes dialog box opens with the Info tab selected.

3. Click the Licenses tab.

4. Make any changes.
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n Select Assign floating to assign floating licenses. Optionally select a license pool to assign
users to.

n Select Assign named to assign named licenses. Named licenses cannot be assigned to inactive
users.

n Select None to remove the license assignments.

5. Click OK to save the changes.

Replacing address field values

Note: LDAP user address information cannot bemodified.

1. Select the users you want to change in the Global Users list.

2. Click Quick Edit and then select Bulk User Changes.

The Bulk User Changes dialog box opens with the Info tab selected.

3. Click theAddress tab.

4. Make any changes. The available options depend on the field type.

n To set the field to a new value, select Set to value and enter or select a value.

n To add text to the beginning of a text field value, select Prepend and enter the text.

n To add text to the end of a text field value, select Append and enter the text.

5. Click OK to save the changes.

Replacing notes field values
1. Select the users you want to change in the Global Users list.

2. Click Quick Edit and then select Bulk User Changes.

The Bulk User Changes dialog box opens with the Info tab selected.

3. Click theNotes tab.
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Changing bulk user fie lds

4. Make any changes.

n To set the field to a new value, select Set to value and enter a value.

n To add text to the beginning of the value, select Prepend and enter the text.

n To add text to the end of the value, select Append and enter the text.

5. Click OK to save the changes.
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Using Single Sign-On
Single sign-on allows LDAP (Active Directory) users to automatically log in to Seapine products using the
same credentials used to log in to their computers, eliminating the requirement to enter a username and
password. For example, if your organization uses a login method, such as secure ID tokens or
biometrics, single sign-on can use this authentication to log in to Seapine products.

To use single sign-on, youmust enable it when you add or edit an Active Directory server connection on
the license server. You can enable single sign-on for individual users or you can require all users to use
single sign-on.

Single sign-on requirements
n The Seapine License Server must be running onWindows as a service in an Active Directory domain.

n By default, the server computer Local System account is used to run the Seapine License Server
application. If a different user runs the application, the user must be a trusted delegate in the Active
Directory domain.

n Users can only use TestTrack 7.6 and later (Mac OS X, Web, orWindows) or Surround SCM 5.0 and
later (Mac OS X orWindows). Client applications running on other platforms are not supported.
Seapine server applications can run on any platform.

n Seapine client applications must run in the same Active Directory domain as the Seapine License
Server or in a subdomain as part of theWindows forest (group of domain trees).

n TestTrack Web users must use Internet Explorer 6.0 or later. TestTrack must be hosted by an IIS web
server withWindows Integrated Authentication enabled.

Configuring single sign-on for LDAP servers
Youmust enable single sign-on for the LDAP server before you can allow users to use it.

1. ChooseView > Server Options.

The Server Options dialog box opens.

2. Select the LDAP category.

3. Select the Active Directory server you want to enable single sign-on for and click Edit.

If you need to add a new server connection, click Add Active Directory. SeeAdding Active
Directory servers, page 17.

The Edit Active Directory Server dialog box opens.

4. Select aSingle Sign-On option.

n Disabled disables single sign-on for all LDAP users associated with the Active Directory server.
Users must manually log in to Seapine products.

n Enabled enables single sign-on for all LDAP users associated with the Active Directory server.
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Enabl ing single sign-on for users

n Required enables single sign-on for all LDAP users associated with the Active Directory server
and restrict them from logging in using a username and password. Single sign-on is automatically
enabled for all users associated with the Active Directory server.

Note: If single sign-on is required, all users associated with the Active Directory server must use
the Seapine product versions and clients that support single sign-on. If the Active Directory server
is not available, users cannot access Seapine products.

5. Click OK to save the changes.

If you enabled single sign-on, youmust also enable it for users. SeeEnabling single sign-on for
users, page 46.

Enabling single sign-on for users
After you enable single sign-on for the LDAP server, youmust enable it for users. Single sign-on can only
be enabled for users retrieved from the LDAP database. SeeAdding LDAP users, page 34.

Note: If single sign-on is required for the LDAP server, all users must it. You cannot enable or disable
single sign-on for each user.

1. ChooseView > Global Users.

TheGlobal Users dialog box opens.

2. Select the user you want to enable single-sign on for.

3. Click Quick Edit and then select Allow Single-Sign On.

Single sign-on is enabled for the user. The user can select the Use single sign-on option on the
Seapine product login dialog box to log in with their network credentials instead of entering a
username and password.

Disabling single sign-on for users
You can disable single sign-on if it is not required for all users associated with the LDAP server.

1. ChooseView > Global Users.

TheGlobal Users dialog box opens.

2. Select the user you want to disable single-sign on for.

3. Click Quick Edit and then select Do Not Allow Single-Sign On.

The user must enter a username and password to log in.
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Managing the Server Log
The Seapine License Server log records server activity and any problems that may occur including errors,
warnings, and timeout and user activity information. The amount of information in the log depends on the
server options you set.

Viewing the server log
1. ChooseView > Server Log.

The View Server Log dialog box opens.

2. Select a Log Filter to filter the log entries.

n Severe Error includes errors that cause incorrect functionality that the user is not notified about.

n Error includes errors handled and reported to the user.

n Warning includes messages about potential problems.

n Unusual Activity includes unusual activity by a user or unusual situations in the database.

n Information includes any activity that may be of interest to the administrator.

3. You can filter the log list evenmore by choosing one of the following options:

n and Less Severe includes the filtered log entries plus less severe entries.

n and More Severe includes the filtered log entries plus more severe entries.

n Only limits the filter to the filtered log entries.
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Exporting the server log

Note: The read-only logged entries field displays how many entries match the restrictions you
chose.

4. Select the entry you want to view.

The details are displayed in the Selected Log Entry area.

Exporting the server log
You can export the server log to a text file for analysis or report generation with other tools.

1. ChooseView > Server Log.

The View Server Log dialog box opens.

2. Click Export Log.

The Export File dialog box opens.

3. Select aSave in location and enter a File name.

4. Click Save.

The log is exported.

Deleting all log entries
You can safely delete log entries if the log becomes too large and you are not experiencing problems.

1. ChooseView > Server Log.

The View Server Log dialog box opens.

2. Click Delete All.

You are prompted to confirm the deletion.

3. Click Yes.

The entries are deleted from the log.

Deleting log entries by date
You can safely delete log entries if the log becomes too large and you are not experiencing problems.

1. ChooseView > Server Log.

The View Server Log dialog box opens.

2. Click Delete by Date.

The Delete Log Entries dialog box opens.

3. Enter a date in theDate field.

4. Click OK.

All log entries, including any entries that occurred on the date you entered, are deleted.
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Setting Up RDBMS Databases
The Seapine License Server database is stored in a Relational DatabaseManagement System
(RDBMS). ODBC (Microsoft SQL Server), Oracle, PostgreSQL, and SQLite are supported. Information
about supported platforms and databases is provided in the Seapine License Server RDBMS Support
knowledgebase article (www.seapine.com/kb/questions/293).

SQLite is the default database type and does not require any setup or configuration before or after
installation. PostgreSQL is also supported out of the box. If you useOracle or SQL Server, review the
following information for help setting up databases.

Setting up PostgreSQL databases
Seapine does not provide support for installing, configuring, or maintaining PostgreSQL. A qualified
PostgreSQL database administrator should install and configure the database.

Keep the following inmind:

n Do not add, delete, or modify any fields in the Seapine License Server tables.

n Do not directly add, edit, or delete any data in the tables.

n Do not create different primary keys. This will adversely affect application performance.

n Do not create complex triggers on any of the tables. Triggers may cause severe database issues and
correcting these issues is not covered by Seapine Software.

n Create a process to back up database tables on a regular schedule.

n Running PostgreSQL and the Seapine License Server on the same computer can result in slow
performance if not configured properly. Make sure PostgreSQL is properly configured to avoid using all
the systemmemory.

Creating server database tables
The Seapine License Server automatically creates tables in PostgreSQLwhen you start the server or
convert the server database. The LSServerDB.sql script file, which is located in the PostgreSQL
directory in the Seapine License Server application directory, is used to create the tables.

Setting up Oracle databases
Seapine does not provide support for installing, configuring, or maintaining Oracle. A qualified Oracle
database administrator should install and configure the database and create the necessary schemas and
tablespaces.

Keep the following inmind:

n Do not add, delete, or modify any fields in the Seapine License Server tables.

n Do not directly add, edit, or delete any data in the tables.

n Do not create different primary keys. This will adversely affect application performance.
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Setting up SQL Server databases

n Do not create complex triggers on any of the tables. Triggers may cause severe database issues and
correcting these issues is not covered by Seapine Software.

n Create a process to back up database tables on a regular schedule.

n Running Oracle and the Seapine License Server on the same computer can result in slow
performance if not configured properly. Make sure Oracle is properly configured to avoid using all the
systemmemory.

Connecting to Oracle
The recommendedmethod for using Oracle is via Oracle Call Interface (OCI). A separate installer that
includes the required Oracle Instant Client libraries can be downloaded from Seapine’s web site.

n Windows—http://downloads.seapine.com/pub/software/OracleInstantClientInstaller.exe

n Mac OS X—http://downloads.seapine.com/pub/software/oraclemacosxjavainstall.zip

n Linux—http://downloads.seapine.com/pub/software/oraclelinuxjavainstall.tar.gz

Creating database tables
The Seapine License Server automatically creates tables when you start the server or convert the server
database. The LSServerDB.sql script file, which is located in the Oracle directory in the Seapine License
Server application directory, is used to create the tables.

Creating Oracle users
Youmust create anOracle user for the Seapine License Server. The user only requires default connection
privileges and should not have any Oracle DBA privileges. Use your preferred tablespacemanagement
for the users. An easy method is to set up the user to share the USERS tablespace and to enable an
unlimited quota.

Database character set
Oracle only converts characters when theOracle client’s character set, specified by NLS_LANG, does
not match the character set stored in the database. If the character set is not UTF-8, VARCHAR2 fields
may not be able to correctly store data. If this happens, the followingmisnomer of an error is returned:
‘ORA-01461: can bind a LONG value only for insert into a LONG column’. TheOracle database character
set should be AL32UTF8 or UTF8.

Sizing, memory, and tuning
Oracle sizing and tuning settings should be consistent with your corporate standards. Review the SQL
scripts for schema creation installed with Seapine License Server to determine the appropriate settings.

Setting up SQL Server databases
Seapine does not provide support for installing, configuring, or maintaining SQL Server. A qualified SQL
Server database administrator should install and configure the database.

Keep the following inmind:
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Troubleshooting RDBMS connections

n Do not add, delete, or modify any fields in the Seapine License Server tables.

n Do not directly add, edit, or delete any data in the tables.

n Do not create different primary keys. This will adversely affect application performance.

n Do not create complex triggers on any of the tables. Triggers may cause severe database issues and
correcting these issues is not covered by Seapine Software.

n Create a process to back up database tables on a regular schedule.

n Running SQL Server and the Seapine License Server on the same computer can result in slow
performance if not configured properly. Make sure SQL Server is properly configured to avoid using all
the systemmemory.

Note: Youmust be amember of the db_ddladmin role and have the CREATE TABLE, CREATE
PROCEDURE, and CREATE VIEW permissions to create the Seapine License Server tables.

Connecting to SQL Server
The only supportedmethod for using SQL Server is via anODBC connection. Use theODBC Data
Source Administrator to add a SQL Server data source name (DSN) on the Seapine License Server
computer.

n SQLServer must contain a Seapine License Server database before you create the DSN.

n Youmust use a system DSN.

n Make sure you change the default database to the Seapine License Server database. Do not use the
master database.

n Make sure theUse ANSI quoted identifiers, ANSI nulls, padding, and warnings, andPerform
translation for character data options are selected.

Creating server database tables
The Seapine License Server automatically creates tables when you start the server or convert the server
database. The LSServerDB.sql script file, which is located in the SQLServer directory in the Seapine
License Server application directory, is used to create the tables.

Troubleshooting RDBMS connections
The following information can help you troubleshoot commonRDBMS issues. Refer to the database
vendor documentation for additional help.

Note: If the Seapine License Server cannot connect to the server database, errors are added to the
LSStartup.log file in the Seapine License Server application directory.

Server database cannot be shared
The Seapine License Server, Surround SCM Server, and TestTrack Server store server configuration
information in a server database. The server databases cannot be located in the sameRDBMS database.
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Troubleshooting RDBMS connections

Dropped tables or change database configuration
Youmust stop and restart the Seapine License Server if you drop server or tables from anRDBMS and
need to re-create them. Youmust also stop and restart the server if you reconfigure the destination
database in the ODBC Data Source Administrator.

The Seapine License Server caches data from the database. If the underlying database is modified, the
cached data no longer matches the data in the database. The connection fails if the server identifies that
the backend database is different and the following error is logged: 'The server failed to initialize a
connection for XYZ. The destination RDBMS database was changed'.

Mismatched UUID affects server database lock
This error occurs when the database is in use by a different Seapine License Server. You are prompted to
reconfigure the database. Do not reconfigure the database if it is used on a different computer. Youmust
manually modify the Seapine License Server connection information to point to a different database and
restart the server. If the database is no longer in use by a different server, reconfigure the database
connection information to allow the current Seapine License Server access to the database.

ODBC connection issues
Try the following if you are experiencing ODBC connection problems.

1. Test the ODBC connection in the ODBC Data Source Administrator.

If you cannot connect to the RDBMS, click the Test Connection button in the ODBC Data Source
Administrator to test the connection.

2. Make sure the DSN is a system DSN.

The data source you are trying to connect to must be configured as a system DSN in the ODBC Data
Source Administrator. The Seapine License Server Admin Utility only displays system DSNs.

ODBC connection errors

Error Cause

[Microsoft][ODBC Driver Manager] Data
source name not found and no default driver
specified QODBC3: Unable to connect

AnODBC data source with the specified DSN was
not set up in the ODBC Data Source Administrator.
The DSN must be a system DSN.
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Troubleshooting RDBMS connections

SQL Server connection errors

Error Cause

[Microsoft][ODBC SQLServer
Driver][SQL Server]Login failed for user
'(null)'. Reason: Not associated with a
trusted SQL Server connection.
QODBC3: Unable to connect

Occurs onWindows. A username is not specified for the
RDBMS connection and theODBC data source was not
configured to run ‘WithWindows NT authentication using
the network login ID’ in the ODBC Data Source
Administrator.

[Microsoft][ODBC SQLServer
Driver][SQL Server]Login failed for user
'xxxx'. QODBC3: Unable to connect

The username or password entered in the RDBMS
connection information is not valid.

Oracle connection errors

Error Cause

ORA-06401:
NETCMN: invalid
driver designator
QOCI: Unable to logon

TheOracle Instant client drivers are not installed. SeeSetting up Oracle
databases, page 49 for information about downloading the installers.

ORA-12705: invalid or
unknownNLS
parameter value
specified QOCI:
Unable to logon

The full Oracle client is installed on the same computer with a language
setting other than UTF8. To resolve this issue, set the following environment
variable:

n Windows—NLS_LANG=AMERICAN_AMERICA.WE8MSWIN1252

n Linux andMac OS X—NLS_LANG=American_America.UTF8

You can also remove the following registry entry to help resolve the issue:
HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\NLS_LANG

Note: Refer to Oracle Metalink article 179133.1, “The Correct NLS_LANG
in aWindows Environment,” for information about the correct setting,
which varies based on theWindows version.

ORA-12514:
TNS:listener does not
currently know of
service requested in
connect descriptor
QOCI: Unable to logon

The service name specified in the RDBMS connection information does not
exist. Make sure that an Oracle listener was created with the specified
service name on the host computer.

This error can also occur if a version of the full Oracle client older than 10g is
installed. If the full client appears in the PATH environment variable, the
older oci.dll may be loaded. To resolve this issue, search for all instances of
the oci.dll file. If multiple copies are found, remove the other copies or
remove their directory reference from the PATH environment variable.
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Troubleshooting RDBMS connections

Error Cause

ORA-12154:
TNS:could not resolve
the connect identifier
specified QOCI:
Unable to logon

The computer specified in the RDBMS connection host name cannot be
found. Make sure the host name is correct and the host computer is running.

ORA-12541: TNS:no
listener QOCI: Unable
to logon

The port number specified in the RDBMS connection information is not a
valid TNS listener port on the specified host computer. Check the host port
number.

ORA-01017: invalid
username/password;
logon denied QOCI:
Unable to logon

The username or password specified in the RDBMS connection information
is not valid. Check the username and password.

PostgreSQL connection errors

Error Cause

Opening the database connection failed because the
Seapine License Server could not connect to the
server or translate the host name

The Seapine License Server cannot connect to
the PostgreSQL service. Check the following
and then restart the server:

n The PostgreSQL service is running.

n The host name and port number are correct.

n A firewall is not blocking the port.

n If connecting to a remote PostgreSQL
server, the server is configured to accept
remote connections.
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Using the Seapine License Server API
The Seapine License Server API provides developers with a dynamic library that can be used to create
custom tools that leverage the Seapine License Server. The Seapine License Server API is available as a
C library, Cocoa framework (Mac OS X only), Java library, and .NET assembly (Windows only). The
Seapine License Server API documentation, which includes all available packages, classes, data
structures, and examples, is installed along with the API library files in your Seapine License Server
application directory in the following locations:

n C API documentation—API/docs/C/index.html

n Cocoa API documentation—API/docs/Cocoa/index.html

n Java API documentation—API/docs/Java/index.html

n .NET API documentation—API/docs/DotNet/index.html

Note: The APIs are not thread safe. Limit the use of any Seapine License Server API to a single
thread.
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Appendix A: LDAP Authentication
Windows supported protocols
The Seapine License Server running onWindows supports the following authentication protocols:

n Simple - Client sends username/password as plain text data over the network. This method is not
secure and should only be used over secure networks or in combination with SSL/TLS encryption.
This is also covered as the SASL PLAIN mechanism, documented in RFC 2595.

n DIGEST-MD5 - Client sends username/password as encrypted text over the network. This method is
only supported for authentication to an Active Directory server.

n GSSAPI (Kerberos) - Client sends authentication token that is generated based on
username/password over the network. This method is secure because it does not send the
username/password over the network. It is only supported onWindows for authentication to an Active
Directory server.

Unix supported protocols
The Seapine License Server running on Unix supports the following authentication protocols:

n Anonymous - Client does not provide any connection parameters, which results in an anonymous
authentication if the server allows it.

n Simple - Client sends username/password as plain text data over the network. This method is not
secure and should only be used over secure networks or in combination with SSL/TLS encryption.
This is also covered as the SASL PLAIN mechanism, documented in RFC 2595.

n DIGEST-MD5 - Client sends username/password as encrypted text over the network.

LDAP technical notes
Most LDAP-enabled application clients are designed to work with a specific, well-defined schema.
Standard applications, such as TestTrack, usually work with a standard schema, such as RFC 2256, A
Summary of the X.500(96) User Schema for use with LDAPv3. The Seapine License Server retrieves
LDAP records based on proposed RFC standards.

n ObjectClass Person (RFC 2256 - A Summary of the X.500(96) User Schema for use with LDAPv3)

n ObjectClass OrganizationalPerson (RFC 2798 - Definition of the inetOrgPerson LDAP Object Class)

n UserID and Email Address (RFC 1274 - The COSINE and Internet X.500 Schema)

Microsoft Active Directory technical notes
Microsoft Active Directory is an LDAP compliant directory service that is supported through the LDAP
configuration. The Seapine License Server retrieves LDAP records based on proposed RFC standards.

n ObjectClass Person (RFC 2256 - A Summary of the X.500(96) User Schema for use with LDAPv3)

n ObjectClass OrganizationalPerson (RFC 2798 - Definition of the inetOrgPerson LDAP Object Class)

n UserID and Email Address (RFC 1274 - The COSINE and Internet X.500 Schema)
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Appendix B: Third-Party Software
Licenses
The OpenLDAP Public License
Version 2.8, 17 August 2003

Redistribution and use of this software and associated documentation ("Software"), with or without
modification, are permitted provided that the following conditions aremet:

1. Redistributions in source form must retain copyright statements and notices,

2. Redistributions in binary form must reproduce applicable copyright statements and notices, this list of
conditions, and the following disclaimer in the documentation and/or other materials provided with the
distribution, and

3. Redistributions must contain a verbatim copy of this document.

TheOpenLDAP Foundationmay revise this license from time to time. Each revision is distinguished by a
version number. Youmay use this Software under terms of this license revision or under the terms of any
subsequent revision of the license.

THIS SOFTWARE IS PROVIDED BY THE OPENLDAP FOUNDATION AND ITS CONTRIBUTORS
AS IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OFMERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NOEVENT SHALL THE OPENLDAP FOUNDATION, ITS
CONTRIBUTORS, OR THE AUTHOR(S) OR OWNER(S) OF THE SOFTWARE BE LIABLE FOR ANY
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDINGNEGLIGENCE OR OTHERWISE) ARISING IN ANYWAY OUTOF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The names of the authors and copyright holders must not be used in advertising or otherwise to promote
the sale, use or other dealing in this Software without specific, written prior permission. Title to copyright
in this Software shall at all times remain with copyright holders.

OpenLDAP is a registered trademark of the OpenLDAP Foundation.

OpenLDAP Copyright
Copyright 1999-2003 TheOpenLDAP Foundation, Redwood City, California, USA. All Rights Reserved.
Permission to copy and distribute verbatim copies of this document is granted. Copyright 1998-2003 The
OpenLDAP Foundation All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted only as
authorized by theOpenLDAP Public License.

A copy of this license is available in the file LICENSE in the top-level directory of the distribution or,
alternatively, at <http://www.OpenLDAP.org/license.html>.

OpenLDAP is a registered trademark of the OpenLDAP Foundation.
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Appendix B: Third-Party Software Licenses

Individual files and/or contributed packages may be copyright by other parties and subject to additional
restrictions.

This work is derived from the University of Michigan LDAP v3.3 distribution. Information concerning this
software is available at <http://www.umich.edu/~dirsvcs/ldap/>.

This work also contains materials derived from public sources.

Additional information about OpenLDAP can be obtained at <http://www.openldap.org/>.

Portions Copyright 1998-2003 Kurt D. Zeilenga.

Portions Copyright 1998-2003 Net Boolean Incorporated.

Portions Copyright 2001-2003 IBM Corporation.

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted only as
authorized by theOpenLDAP Public License.

Portions Copyright 1999-2003 Howard Y.H. Chu.

Portions Copyright 1999-2003 Symas Corporation.

Portions Copyright 1998-2003 Hallvard B. Furuseth.

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that this notice is preserved. The names of the copyright holders may not be used to endorse or promote
products derived from this software without their specific prior written permission. This software is
provided as is'' without express or implied warranty.

Portions Copyright (c) 1992-1996 Regents of the University of Michigan.

All rights reserved.

OpenSSL license
The following license information pertains specifically to the OpenSSL toolkit.

TheOpenSSL toolkit stays under a dual license, i.e. both the conditions of the OpenSSL License and the
original SSLeay license apply to the toolkit. See below for the actual license texts. Actually both licenses
are BSD-style Open Source licenses. In case of any license issues related to OpenSSL please contact
openssl-core@openssl.org.

OpenSSL license
Copyright (c) 1998-2008 TheOpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions aremet:

1. Redistributions of source codemust retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.
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Appendix B: Third-Party Software Licenses

3. All advertisingmaterials mentioning features or use of this softwaremust display the following
acknowledgment: "This product includes software developed by theOpenSSL Project for use in the
OpenSSL Toolkit. (http://www.openssl.org/)"

4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to endorse or promote
products derived from this software without prior written permission. For written permission, please
contact openssl-core@openssl.org.

5. Products derived from this softwaremay not be called "OpenSSL" nor may "OpenSSL" appear in
their names without prior written permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following acknowledgment: "This product
includes software developed by theOpenSSL Project for use in the OpenSSL Toolkit
(http://www.openssl.org/)"

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY EXPRESSED OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDINGNEGLIGENCE OR OTHERWISE) ARISING IN ANYWAY OUTOF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
====================================================================

This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This product
includes software written by Tim Hudson (tjh@cryptsoft.com).

Original SSLeay license
Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)

All rights reserved.

This package is an SSL implementation written by Eric Young (eay@cryptsoft.com). The implementation
was written so as to conform with Netscape's SSL.

This library is free for commercial and non-commercial use as long as the following conditions are
adhered to. The following conditions apply to all code found in this distribution, be it the RC4, RSA, lhash,
DES, etc., code; not just the SSL code. The SSL documentation included with this distribution is covered
by the same copyright terms except that the holder is Tim Hudson (tjh@cryptsoft.com).

Copyright remains Eric Young's, and as such any Copyright notices in the code are not to be removed.

If this package is used in a product, Eric Young should be given attribution as the author of the parts of the
library used.

This can be in the form of a textual message at program startup or in documentation (online or textual)
provided with the package.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions aremet:

1. Redistributions of source codemust retain the copyright notice, this list of conditions and the
following disclaimer.

61



Appendix B: Third-Party Software Licenses

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertisingmaterials mentioning features or use of this softwaremust display the following
acknowledgement: "This product includes cryptographic software written by Eric Young
(eay@cryptsoft.com)" The word 'cryptographic' can be left out if the routines from the library being
used are not cryptographic related :-).

4. If you include any Windows specific code (or a derivative thereof) from the apps directory (application
code) youmust include an acknowledgement: "This product includes software written by Tim
Hudson (tjh@cryptsoft.com)"

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG ``AS IS'' AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA,
OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDINGNEGLIGENCE
OR OTHERWISE) ARISING IN ANYWAY OUTOF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The license and distribution terms for any publicly available version or derivative of this code cannot be
changed. i.e. this code cannot simply be copied and put under another distribution licence [including the
GNU Public Licence.]

Cyrus SASL information
CMU libsasl

Tim Martin

Rob Earhart

Rob Siemborski

Copyright (c) 1998-2003 CarnegieMellon University. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions aremet:

1. Redistributions of source codemust retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. The name "CarnegieMellon University" must not be used to endorse or promote products derived
from this software without prior written permission. For permission or any other legal details, please
contact Office of Technology Transfer, CarnegieMellon University, 5000 Forbes Avenue, Pittsburgh,
PA 15213-3890, phone: (412) 268-4387, fax: (412) 268-7395, tech-transfer@andrew.cmu.edu.

4. Redistributions of any form whatsoever must retain the following acknowledgment: "This product
includes software developed by Computing Services at CarnegieMellon University
(http://www.cmu.edu/computing/)."
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CARNEGIE MELLON UNIVERSITY DISCLAIMS ALLWARRANTIES WITH REGARD TOTHIS
SOFTWARE, INCLUDINGALL IMPLIED WARRANTIES OFMERCHANTABILITY AND FITNESS, IN
NOEVENT SHALLCARNEGIE MELLON UNIVERSITY BE LIABLE FOR ANY SPECIAL, INDIRECT
OR CONSEQUENTIAL DAMAGES OR ANY DAMAGESWHATSOEVER RESULTING FROM LOSS
OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR
OTHER TORTIOUS ACTION, ARISINGOUTOFOR IN CONNECTION WITH THE USE OR
PERFORMANCE OF THIS SOFTWARE.
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